This presentation will provide an overview of the features of the IBM WebSphere® Telecom
toolkit.

Toolkit version 7.0 with an emphasis on the Telecom Application Enablement feature of the
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Goals

* Introduce the telecom application enablement
feature in WebSphere Telecom Toolkit V7.0

= Understand the usage of the tools available in the
Telecom application enablement feature

Overview and features © 2009 IBM Corporation

The goal of this presentation is to introduce the new development features in the Telecom
Application Enablement feature of the Toolkit. These new and exciting features simplify
various aspects of developing IP Multimedia Subsystem (IMS) client applications and
server side enablers. This presentation will provide a brief overview of the functionality and
usage of the various tools provided by this feature.
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Agenda

= Overview

= Installation

» Development tools
= Test tools

= Samples

= Online Help

Overview and features © 2009 IBM Corporation

The presentation agenda starts with a general overview of the feature, followed by a walk-
through of the installation steps. It then highlights the development and test tools,
samples, and online help provided by the telecom application enablement feature.
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Overview

= Two installable features

» Telecom Web services feature
» Telecom application enablement feature

= Telecom Application Enablement feature

» Tools to develop and test

= XML Configuration Access Protocol (XCAP), Session Initiation Protocol (SIP)
and Diameter web-services based applications and services.

= Telecom Web services feature (Not covered in this
presentation)

» Build and test telecom Web services client applications using Parlay X 2.1 API's

Overview and features © 2009 IBM Corporation

The WebSphere Telecom Toolkit consists of the telecom Web services feature and the
telecom application enablement feature. The telecom application enablement feature
provides a collection of tools for developing IP Multimedia Subsystem client applications
and server side enablers. Each of these tools is explained in greater detail later in the
presentation.

This presentation covers only the telecom application enablement feature of the toolkit.
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Installation

= Extension to Rational® Application Developer V7.5

= Available on Windows® and Linux® operating
systems

* Installed as a feature of WebSphere Telecom
Toolkit V7.0

= Getting Started guide includes installation and
removal procedures

Overview and features © 2009 IBM Corporation

The Toolkit is built as an extension to Rational Application Developer version 7.5. It is
available on Windows XP and Linux operating systems that Rational Application Developer
7.5 supports. The toolkit is installed with an InstallAnywhere installer. The Telecom
Application Enablement feature and Telecom Web services feature are two independent
features of the toolkit with no dependency on each other and can be installed separately.
The getting started guide shipped with the toolkit covers the installation and uninstall
instructions for both Windows and Linux operating systems.
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Telecom application enablement tools

» Development tools overview

» Application development tools for

= Diameter, Presence, SIP, XML Document Management Server (XDMS),
IMS Session Control (ISC)

» Import wizard to import IMS Resources into a project
» Add Libraries utility to add IMS libraries to a project

» Samples to demonstrate usage
= Diameter, Presence, SIP, XDMS, and IMS Session control Samples

Overview and features © 2009 IBM Corporation

The various tools available in the Telecom Application Enablement feature are as follows:

- Development tools for developing IMS applications based on Diameter Web services,
Session Initiation Protocol standards, SIP for Instant Messaging and Presence Leveraging
Extensions standards, and XML Document Management applications based on Open
Mobile Alliance standards.

- An Import Wizard for importing IMS resources such as libraries, scripts, and Web service
descriptor language files into a dynamic Web project based on Java™ EE specification
standards.

- An Add Library utility to add the IMS library jar files to the class path of a project.
- Awide range of samples that includes
> Diameter Ro, Rf, and Sh Web services clients

> Rich presence enabled samples, IMS Session Control SIP samples that use Diameter
Ro and Rf interfaces to demonstrate how online and off-line charging can be applied to a
SIP transaction.

> An XCAP client and several XML Document management enablers based on Open
Mobile Alliance standards.

Refer to the Samples module to learn more about how to set up and use the samples.
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Telecom application enablement tools continued

» Test tools overview

» Client editors supporting
= SIP protocol
= XCAP protocol
= Diameter Rf Web service
= Diameter Sh Web service

» Code snippet generator
» Import/Export batch requests

Overview and features © 2009 IBM Corporation

The test tools support running single or batched client requests for SIP and XCAP
protocols, and Diameter Rf, Ro, and Sh Web services.

The client tools offer a way to generate code snippets for all the supported APIs. The
batched requests can be saved to and reloaded from a file system.

Refer to the client tools module for more information on using these test tools.
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Wizards - development tool

© Import TAE Resources o] x]

* To import TAE resources Import TAE Resources

Select Telecom Application Enablement (TAE) Resources to import into the

into a project S ————
[ Telecom Appiication Enablement Resources
» Diameter libraries and WSDLs for [P e
developing applications that use I wsoL
Diameter Web services =i
» Presence libraries for developing LA
WebSphere Presence Server fani=prasil
extensions L5
» SIP libraries for SIP header -
parsing and SIPp scenario files
» XDMS Libraries for XCAP and
XDMS applications -

The Import Telecom Application Enablement wizard is used to import various Java
libraries, Web service descriptors, and scripts into an existing Web or Java project for
development of converged applications that make use of these resources.

The Java libraries are recommended to be imported into a Web module project for
development of converged applications that make use of both Web resources along with
telecom resources. When imported into a Web project, the library is imported into the lib
folder of the project. Importing these resources into the lib folder enables the packaging of
these resources for easy deployment when Web applications are exported into a Java EE
Web archive.

These import resources include —

- the Diameter libraries and Web service Description Language files for the Diameter Rf,
Ro, and Sh Web services,

- the presence libraries for creating the IBM WebSphere Presence Server extensions,
- SIPp scripts for testing subscribes and publish scenarios,

- the SIP library, which contains the classes to find and add P-Asserted Identity and
change P ChargingVector headers,

- and the XML Document Management resources, which have the core and utility classes
and API for developing new IBM XDMS enablers or to add extensions to these enablers.
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Add libraries utility — development tool

= Facility to add libraries M"“*"v —— 1ox]
» Diameter Select a ibrary to add to the classpath =)
» Presence R e
™ Diameter Libraries
’ SIP ™ Presence Libraries
> XDMS ™ SIP Wity Libraries

™ XDMS Client Libraries

= Launching this utility

» Right click Project -> Properties -
> Java Build Path -> Libraries
Page -> Add Library -> Telecom
Application Enablement Toolkit
Libraries

) [<g&k | te [ B | cacel

I @R ~ L%

Overview and features © 2009 IBM Corporation
The Add Libraries Utility, available through the Java Build Path wizard launched from the
Properties function of a Web project, provides the same libraries available through the
import Telecom Application Enablement resources wizard. The difference is that the Java

Build Path wizard adds the library to the class path of the project verses adding it to the lib
folder.

Adding the libraries to the class path enables any new user code to reference the classes
in the libraries. These libraries are not packaged into a Web archive when the project is
exported to create a deployable Web archive as the class path of the project is a
development time artifact only. Adding the libraries using the class path approach can be
used when the libraries are already deployed on the application server where the Web
archive is deployed. Using the class path approach will not duplicate the libraries since
they will not be included in the Web archive when they are already available on the
application server. The class path approach can also be used for a stand-alone Web
service client application.
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Test tools

= Four test clients, each targeted to test a specific
protocol or a Web service

» Each client built as an editor

= Based of a telecom application enablement
batched request script

= Wizard available to create a new script
» Creates an .ims file in the selected project

= Tests can be run as single or batched tests

= Batched tests can be saved in .ims file

Overview and features © 2009 IBM Corporation

The test tools in the toolkit include four test clients, each targeted to build client side tests
for a specific protocol or Web service in accordance to the protocol standards or Web
service specification. Each client is built as an editor which provides fields to enter values
in order to create the client tests.

The four test clients are run based off a Telecom Application Enablement Batched Request
script file. The tools provide a wizard to create this script. The wizard allows you to give a
custom name to the script and generates a file with an .ims extension. Running the wizard
results in creating a this file and launching the clients. The .ims file is used to store any
reusable batched tests you create using the test clients. All the clients provide the flexibility
of running the tests as individual tests or as a batched request. The steps to configure
each of the test clients and to create single or batched tests is explained in more detail in
the Client Tools education module.
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Test tools

= XCAP client
» Test add, delete, update and query operations of XML
documents against an XCAP server
= SIP client
» Test SIP requests using SIPp open source SIP traffic
generation runtime
= Diameter Rf and Sh clients

» Test object methods of offline charging Rf and subscriber
profile Sh Web services

Overview and features © 2009 IBM Corporation

The test tools include the XCAP Client used to create and run XCAP requests to add,
delete, update, and query XML documents on an XCAP complaint server such as the IBM
XML Document Management Server (XDMS). IBM XDMS adheres to Open Mobile
Alliance XML document management specifications.

The XCAP client provides a configurable user interface with fields for entering values to
build XCAP requests as per the XCAP specification.

The SIP Client is built on top of the SIPp runtime, which is an open source traffic
generation tool for the SIP protocol. You can learn more about SIPp at the
http://sipp.sourceforge.net/ Web site. The SIP client provides a user interface to run SIPp
scripts with all the configurable options. SIPp provides you with a pre-built SIPp scenario
script.

The Diameter Rf and Sh test clients provide the ability to test the object methods of the
offline charging Rf and the subscriber profile Sh Web service using manually configured
parameters for the methods. To learn more about configuring and using each of the test
clients, refer to the Client Tools education module.
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Samples

= Diameter sample

» For testing design parameters for applications against the Rf, Ro and
Sh Web services

= Presence sample
» SIP External Source sample demonstrate the behavior of a SIP
external source using SIPp scripting

» Presence REST Sample demonstrate the use of RESTAPI in
presence server

= SIP samples

» Demonstrate online and offline charging of SIP transaction using Ro,
Rf interfaces and IMS Session Control

The toolkit provides several IMS samples in the online help under the Telecom Application
Enablement feature sub category of the samples directory. These samples enable
developers to quickly understand the API’s provided and efficiently develop new client
applications and server side extensions for the Diameter, rich presence, IMS session
control, and XML document management services.

The Telecom Application Enablement samples are categorized based on the various
services offered by IBM IMS services and include:

- The Diameter samples category which includes samples to demonstrate how to design
the test parameters for client applications of offline charging Rf, online charging Ro, and
subscriber profile Sh diameter Web services.

- The Presence samples category which includes two samples,

> the SIP external source sample is a SIPp script scenario that demonstrate the
behavior of a SIP external source.

> the REST sample is Web application that demonstrate how to retrieve rich presence
information from a presence server using REST API.

- The SIP Sample category which includes a sample that demonstrates how online and
offline charging can be done for a SIP transaction using the online charging Ro and offline
charging Rf diameter Web services and IMS Session Control interfaces.
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Samples

= XDMS samples
» XCAP client sample
» XDMS template
» SharedList sample
» PresRules sample
» Shared group sample
» Shared policy sample
» Shared profile sample
» Shared enablers sample

Overview and features © 2009 IBM Corporation

The XDMS sub category includes several samples for building XCAP client application
and server side enablers. The samples include:

- The XCAP Client sample, which demonstrates running XCAP batched requests against
an XCAP complaint server like the IBM XML Document Management server.

- The XDMS Template sample, which contains template SIP and Web servlets and core
XML schema files for developing new XML document management enablers based on the
open mobile alliance XML document management standards.

- The Shared List, Presence Rules, Shared Group, Shared Policy, Shared Profile, and
Shared Enabler XDMS samples provide the corresponding Http and SIP servlets and the
core XML schema files. These Web and SIP artifacts are packaged as a Web application
for managing ris-services and resource-lists XML documents. These documents are based
on open mobile alliance XML document management standards.

To learn more about the setup and use of each of the telecom enablement samples, refer
to the Samples education module.
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Online help

= Toolkit online help
» Launched using Help ->

Help Contents -> Expanding

Telecom Enablement feature

© Help - Rational® Application Developer™ for WebSphere® Software

Sach: [ |[E seachscooe Altopcs

Contents

¢o-loB o

®

5@

SIP Tools Developer Guide -

T Applicati

Feature

# (14 Feature overview
& [ Diameter Enabler
@ [ Presence Server

I Telecom Application Enablement SIP clients

# (14 Developing custom IBM XDMS applications
% (14 Developing XDMS XCAP cients
w

Telecom Web Services Feature
»

g L & [ 5

f Ovaiew and features
The Telecom Application Enablement feature of the toolkit provides comprehensive online
help on various tools topics as shown in the figure. The help system of the tool provides a
wealth of information on how to efficiently use the tools to meet your needs. The online
help can be launched by selecting Help -> Help Contents and then expanding the Telecom

Application Enablement feature topic.
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